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About the DR2000v Deployment Guide
The DR2000v Deployment Guide provides instructions for deploying the DR2000v, a virtual DR Series system.
This guide contains topics that explain how to deploy the DR2000v system in your environment.

Other information you may need
The following table lists the documentation available for the DR Series systems. The documents listed in this table
are available on the Quest support website by selecting your specific DR Series system model at:
http://support.quest.com/DR-Series
For more information about the DR Series system hardware, see the safety and regulatory information that
shipped with your DR Series system. Warranty information might be included as a separate document.
Document

Description

DR Series System Getting Started Guide

Provides an overview of how to set up the physical
DR Series system hardware and includes technical
specifications.

DR Series System Owner's Manual

Provides information about applicable physical DR
Series system features, troubleshooting the DR
Series system, and installing or replacing the DR
Series system components.

DR2000v Deployment Guide

Provides information about deploying the virtual
DR Series system, DR2000v, on supported virtual
platforms.

DR Series System Administrator Guide

Provides information about managing backup and
replication operations using the DR Series system
GUI.

DR Series System Interoperability Guide

Provides information on supported hardware and
software for the DR Series systems.

DR Series System Command Line Reference Guide

Provides information about managing DR Series
system data backup and replication operations using
the DR Series system command line interface (CLI).

DR Series System Release Notes

Provides the latest information about new features
and known issues with a specific product release.

NOTE: You should check for the latest documentation updates and release notes at support.quest.com/
dr-series, and read the release notes first because they contain the most recently documented information
about known issues with a specific product release.
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Getting started
This chapter provides an introduction to the DR2000v system and describes specifications, usage notes, and
other important information that you need before you begin to deploy your system. It includes the following topics:
•

Introducing the DR2000v— provides an introductory description of the DR2000v.

•

Specifications and Usage Notes for the DR2000v — provides important information about licensing and
usage for the DR2000v.

•

NIC Drivers and Settings — provides important information about NIC driver updates for your hypervisor
host and NIC settings for the DR2000v.

•

Setting up Licensing for the DR2000v— provides important information about how to set up your license
on the DR2000v.

Introducing the DR2000v system
The DR2000v is a virtual DR Series system that provides backup and disaster recovery (DR) features such as
deduplication, compression, replication, and advanced data protection. This virtual appliance runs inside a virtual
machine (VM) on a VMware ESXi or Microsoft Hyper-V server. The DR2000v uses storage disks resident in
the hypervisor server on which it is loaded. The DR2000v virtual machine (VM) template is available in various
licensed capacities that can be deployed on your existing VM infrastructure. Backup/restore performance using
the DR2000v is dependent on the performance of your underlying hardware.

Specifications and notes for using the
DR2000v
This section describes special notes on usage, licensing information, GUI usage limitations, and latest driver
downloads for the DR2000v system.
NOTE: For detailed information about supported virtual machine platforms and versions, platform
configuration limits, virtual infrastructure and memory requirements, and other related system information,
see the DR Series System Interoperability Guide.
Virtual Tape Library
Virtual Tape Library (VTL) support is available on the DR2000v in demo mode for trial and proof of concept only.
To learn more about this functionality, contact your sales representative to request a VTL demo license for the
DR2000v. To download the trial version, visit the following link: https://www.quest.com/products/dr2000v-virtualbackup-appliance/software-downloads.asp
Licensing
The DR2000v uses a standalone license.
NOTE: The DR2000v 30-day trial version does not require a license to be installed on a DR Series
hardware system for operation.

DR2000v Deployment Guide
Specifications and notes for using the DR2000v

4

DR2000v Hyperscale licensing
VM Hyperscale licenses are deployed on the DR Series appliance to support and maintain multiple virtual
DR2000v appliances that are licensed by a single DR Series hardware system. A DR Series hardware system
can support up to 3,000 virtual machines.
NOTE: A DR Series hardware system with a Hyperscale license can function as a regular DR Series
system.
For more information on DR2000v license limits, see the DR Series System Interoperability Guide. For more
information about DR2000v Hyperscale licensing, contact your sales representative or Quest support.
DR2000V VM cloning and importing/exporting
When cloning or importing/exporting a VM, a cloned VM requires a new license. Contact Quest support for
assistance.
DR Series system GUI usage
Refer to the following notes about GUI usage specific to the DR2000v.
•

You should not change the MTU setting for the DR2000v but should leave the setting at the system default
of 1500.

•

The DR Series system GUI Usage menu displays only statistics related to DR2000v; no underlying hosting
virtual machine platform information is available through this menu.

•

DR Series system alerts and events are applicable only to DR2000v; no underlying hosting virtual machine
platform alerts/events are handled.

•

The DR2000v system is a Global View-managed unit, which means it can be added to the Global View of
your DR Series hardware system.

•

Hardware Health is not displayed in the GUI for the DR2000v as this is managed via the hosting platform.

NIC drivers and settings
Refer to the following topics for important information about NIC driver updates for your hypervisor host and NIC
settings for the DR2000v.

Hyervisor host NIC driver updates for VMQ
Before deploying the DR2000v, you may need to update certain hypervisor host NIC drivers to support the VMQ
feature. Check your Hypervisor host NIC feature list and update the driver to the latest version as needed. For
example, you should update the Broadcom NetXtreme I and NetXtreme II Ethernet adapter driver to 17.6.0 (or
later) to add VMQ support; otherwise, you might experience performance degradation during normal operations.
Refer to the following links for downloading:
•

Driver for NetXtreme I and NetXtreme II Ethernet adapter:
http://www.dell.com/support/home/us/en/19/Drivers/DriversDetails?
driverId=CYKKJ&osCode=MWS80&fileId=3197327398&languageCode=EN&categoryId=NI

•

Firmware for NetXtreme I and NetXtreme II Ethernet adapter:
http://www.dell.com/support/home/us/en/19/Drivers/DriversDetails?
driverId=P32M4&osCode=MWS80&fileId=3197328666&languageCode=EN&categoryId=NI
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DR2000v NIC settings
The DR2000v is designed to work with two virtual NICs. Internally, the DR2000v bond’s both the NICs to be
Transmit Load Balancing (TLB), which requires the eth-0 MAC address for the ethernet traffic. For the DR2000v
appliance to work properly, you should ensure the following settings:
1.

Ensure that the eth-0 NIC is always connected to a valid Hypervisor Virtual Switch topology.

2.

Ensure that eth-0 line is always up and running.

3.

Enabling the eth-1 is optional, but if you enable it:
a.

Ensure the virtual switch settings MAC address changes and Forged Transmits are set to Accept, if
you are planning to use eth-1 in an ESXi hypervisor environment.

b.

Ensure the eth-1 interface is not connected if you do not have the administrator privileges.

4.

If you are making any network setting changes on your hypervisor, execute the stats –network CLI
command to list all the NIC ports status, especially with the Rx/Tx counts.

5.

If the eth-1 “Rx” counters are not getting incremented, but the “Tx” counters are getting incremented, then
you might have a problem with your switch settings, where the return traffic is getting dropped by your
Hypervisor vSwitch. To resolve this, see Step 3 above.

Setting up licensing for the DR2000v
The DR2000v uses a standalone license. For more information about licensing, see the topic, Specifications and
notes for using the DR2000v. For information about licensing limits for the DR2000v, see the DR Series System
Interoperability Guide.
NOTE: The DR2000v 30-day trial version does not require a license to be installed for operation. If you will
be deploying a trial version of the DR2000v, see the topic “Deploying the DR2000v Trial Version” later in
this guide for detailed instructions.

Installing a license for the DR2000v
Before you begin, refer to these important notes about installing standalone licenses for the DR2000v:
•

Evaluation license - If you install a standalone license on a DR2000V on which an evaluation license is
already installed, the evaluation license will be deleted.

•

License expiration - A standalone license has no expiration and remains valid for the lifetime of the virtual
machine (VM) unless explicitly enforced in future software upgrades, and no other license can be installed
above this perpetual license.

•

DR2000v RM Recovery/Restore - A standalone license in not recovered in the case of RM recovery/
Restore. You would therefore need to reinstall the old license.

Follow these steps to install the DR2000v license.
1.

Open a web browser and enter the DR2000v IP address to access the DR Series system GUI.

2.

Enter the default credentials to log on: Username: administrator, Password: St0r@ge!

3.

Navigate to the GlobalView page.

4.

On the GlobalView page, view and record the service tag of the DR2000v for which you want to install a
standalone license (this service tag would have been added for the trial period for the DR2000v, and this
service tag is required for acquiring the standalone license from the support team).

5.

Contact the Technical Support team with the service tag number to acquire the new standalone license
(.dlv) file, and then store the file somewhere on your system or network for uploading to your DR Series
system.
DR2000v Deployment Guide
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6.

Once you have obtained the new license file, navigate to System Configuration > Licenses in the GUI.

7.

Click the Select License File button.

8.

Upload the license .dlv file, and click Install. A success alert appears and the service tag changes when the
file has been successfully uploaded.

9.

To view the new service tag, go back to the GlobalView page and look for the service tag for the DR2000v.
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Deploying the DR2000v on VMware
ESXi
This topic provides information about deploying the DR2000v on VMware ESXi.
For detailed information about supported VMware ESXi versions, platform and license limits, virtual infrastructure
and memory requirements, and other information, see the DR Series System Interoperability Guide.
The deployment process comprises the following tasks:
1.

Deploying the DR2000v via one of the following:
◦

Using the vSphere Client

◦

Using the vSphere Web Client
NOTE: The security policy for vSwitches in VMware environments should be configured to allow
MAC Address Changes, this can be achieved by enabling the Allow MAC Address changes and
Forged Transmits option in the Layer-2 security policies of the vSphere vSwitches. To edit the Layer
2 security policies of vSphere vSwitches, navigate to Security Policy settings and set the value for
the MAC Address Changes and Forged Transmits to Accept. For more information about security,
see the vSphere Security documentation.

2.

Setting up and configuring the DR2000v.
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Deploying the DR2000v using the vSphere
Client
The following instructions describe the steps for deploying the DR2000v on VMware ESXi using the vSphere
client.
1.

Acquire the DR2000v installation package and store it on your system or a network location. This package
is in VMware ESXi ova format.

2.

Launch the vSphere client, and log on to the vCenter server or the ESX host.( If you are using ESXi
version 5.5, use the Web client, since the vSphere client does not work with 5.5. See the topic, “Deploying
DR2000v using the vSphere Web Client,” for more information about deploying using the Web client.)

3.

In the vCenter management console, highlight the ESX host that will be hosting the VM, and then select
File > Deploy OVF Template.

4.

In the Deploy OVF Template - Source dialog box, click Browse.

5.

Browse to the location of the DR2000v .ova package on your system or network, select it, and click Open.

6.

In the Deploy OVF Template - Source window, click Next.

7.

In the Deploy OVF Template - OVF Template Details dialog box, click Next.

8.

In the Deploy OVF Template - Name and Location dialog box, enter the Virtual Machine (VM) name and
click Next.

9.

In the Deploy OVF Template – Storage dialog box, choose a data store that meets the storage space
requirement (with minimum free space of at least the size the of the DR2000v system), and then click Next.

10. In the Deploy OVF Template - Disk Format dialog box, choose a storage provisioning method, and then
click Next.
Note that selecting thin provisioning will require the space to be allocated as needed and may result in
additional performance impact.
11. In the Deploy OVF Template — Ready to Complete dialog box, review the deployment information, select
Power on after deployment, and click Finish.
If the network setting does not default to the network you want, you might have to edit the network mapping
after this setup.
A dialog box appears to show progress of the deployment process.
12. In the Deployment Completed Successfully dialog box, click Close.
The DR2000v will boot up. (It takes approximately 3-5 minutes to self-extract the installation package and
install all of the components.)
13. Proceed with the initial setup and configuration of the DR2000v. Refer to the topic, “Setting up and
Configuring the DR2000v,” for instructions.
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Deploying the DR2000v using the vSphere
Web Client
The following instructions describe the steps for deploying the DR2000v on VMware ESXi using the vSphere web
client.
1.

Acquire the DR2000v installation package and store it on your system or a network location. This package
is in VMware ESXi ova format.

2.

Launch and log on to the vSphere Web Client.

3.

Right-click the ESXi host that will host the DR2000v, and select Deploy OVF Template.

4.

In the Deploy OVF Template - Source window, click Browse to locate the DR2000v .ova template on your
system or network location, and click Open.

5.

Click Next to proceed.

6.

Review details in the Deploy OVF Template dialog box, and then click Next to proceed.

7.

In the Deploy OVF Template – Select Name and Folder dialog box, enter a Name for the virtual machine
and select the folder that hosts it, and then click Next to proceed.

8.

In the Deploy OVF Template – Select Storage dialog box, select the virtual disk format and the destination
datastore, and then click Next to proceed. You must choose a data store that meets the storage space
requirement (with minimum free space of at least the size the of the DR2000v system).
It is recommended that you select the setting, Thick Provision Eager Zeroed, which will result in ESX
Physical CPU Usage until the storage is allocated and zeroed. (Selecting Thin Provision will result in
fragmented disks because the storage is provisioned as required.)

9.

In the Deploy OVF Template - Setup Networks dialog box, configure the networks that the deployed
template should use, and click Next to proceed.

10. In the Deploy OVF Template — Ready to Complete dialog box, review the settings, select Power on after
deployment, and click Finish.
A dialog box appears to show progress of the deployment process.
11. In the Deployment Completed Successfully dialog box, click Close.
The DR2000v will boot up. (It takes approximately 3-5 minutes to self-extract the installation package and
install all of the components.)
12. Proceed with the initial setup and configuration of the DR2000v. Refer to the topic, “Setting up and
Configuring the DR2000v,” for instructions.
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Deploying the DR2000v on Microsoft
Hyper-V
The topics in this section provide information about deploying the DR2000v on Microsoft Hyper-V.
For detailed information about supported Microsoft Hyper-V versions, platform and license limits, virtual
infrastructure and memory requirements, and other information, see the DR Series System Interoperability Guide.
Before you begin the deployment process, ensure you have met the prerequisites described in the topic,
“Prerequisites for the DR2000v on Microsoft Hyper-V.”
The deployment process comprises the following tasks:
1.

Deploying the DR2000v on one of the following:
◦

On a local Hyper-V Host

◦

On a remote Hyper-V Host
NOTE: As Microsoft only supports OVF format on system center Virtual Machine Manager, using
the Power Shell scripts, the DR2000v appliance’s deployment for the Hyper-V infrastructure is
made easier, and the procedure for creating virtual appliance with required settings is automated.

2.

Converting the disk to fixed disk.

3.

Setting up and configuring the DR2000v.

Prerequisites for deploying the DR2000v
in Microsoft Hyper-V environments
Make sure you have installed the DR2000v license on an associated DR Series system hardware appliance, if
needed. For more information, see the topic “Setting up the license for the DR2000v” in this document.

NOTE: These prerequisites are applicable to Microsoft Windows 2008 R2, 2012, and 2012 R2 Hyper- V
environments.
To deploy the DR2000v on Microsoft Hyper-V and to use the DR2000v Hyper-V cmdlets, ensure that the following
prerequisites are met. For more information about the available DR2000v Hyper-V cmdlets, see the topic, “Using
the Suppported cmdlets for DR2000v for Hyper-V” in this document.
1.

Required User Privileges:
You must have administrator privileges or you must be a member of the administrator’s group

2.

Extract the downloaded DR2000v installation package on the Hyper-V host to access its files. It may take
couple of seconds for the files to be extracted. Before executing the Hyper-V installation process the
following software pre-requisites are required:
NOTE: This software is easily accessible from the Pre-Requisites folder. The pre-requisite file names
may change due to different DR2000V OS versions release and also other updates may be required.
◦

Installing .NET Framework 4.5
DR2000v Deployment Guide
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NOTE: For convenience both online and offline version of .NET 4.5 is available along with
the .NET security update packages. For this deployment use the .NET Framework 4.5.1 offline
full install option along with the two security update file of .NET.
◦

Installing Windows PowerShell 4.0
Windows PowerShell 4.0 is part of the Windows Management Framework 4.0. Refer to the following
link for more information: http://www.microsoft.com/en-us/download/details.aspx?id=40855.

◦

Installing Windows Remote Management (WinRM) v2.0
WinRM is the Microsoft implementation of the WS-Management Protocol. It uses Simple Object
Access Protocol (SOAP) over HTTP and HTTPS. For remote operations, port 5985 must be enabled
on the Windows Firewall for remote management on the target server. Refer to the following links for
more information:
▪

msdn.microsoft.com/en-us/library/aa384372(v=vs.85).aspx

▪

http://blogs.technet.com/b/askperf/archive/2010/09/24/an-introduction-to-winrmbasics.aspx

Additional prerequisites for deploying the DR2000v in Microsoft Windows 2008 R2 Hyper- V environment
Installing PowerShell Management Library for Hyper-V from Codeplex
This prerequisite is an Open Source project that provides a PowerShell management library for Hyper-V. It is
based on Microsoft Public License (MS-PL). You can download the binaries from the following location: https://
pshyperv.codeplex.com/releases.
•

Download the R2 SP1 version and save in the PreRequisites directory.

•

This product is not signed hence the PowerShell Execution Policy has to be set to Unrestricted. To
do so, enter the following command in PowerShell with elevated privileges: Set-ExecutionPolicy
Unrestricted.

•

Press y to change the execution policy.

•

Reboot the server.

Once you have extracted the content of PsHyperV.zip, you need to unblock the content because Windows
attempts to block scripts downloaded from the Internet. To unblock the content using Windows Explorer:
1.

Open Windows Explorer, and navigate to the temporary HyperV folder.

2.

Right-click the first file in the folder and select Properties.

3.

When the file properties is displayed, click Unblock and OK. Repeat this to unblock all the files in the
folder.

4.

After all the files are unblocked, move the folder HyperV to %WINDIR%\System32\WindowsPowerShell
\v1.0\Modules\ location.

5.

Import the modules from this library by executing the following PowerShell commands:
◦

Get-Module -ListAvailable -Name HyperV

◦

Import-Module -Name HyperV -WarningAction SilentlyContinue
NOTE: The output displayed in red is normal.

◦

Get-Module -Name HyperV

Additional prerequisites for deploying the DR2000v in Microsoft Windows 2012 and 2012 R2 Hyper- V
environment
Installing the Hyper-V Management Tools
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This prerequisite is a Windows feature that contains a PowerShell extension to manage Hyper-V servers on
Windows 2012 and 2012 R2 systems. Using PowerShell install this feature, enter the following commands with
elevated privileges:
•

Install-WindowsFeature Hyper-V-Tools – This command enables Windows to administer Hyper-V.

•

Install-WindowsFeature Hyper-V-PowerShell – This command installs additional PowerShell
commands specialized for Hyper-V.

•

Set-ExecutionPolicy AllSigned – This command allows scripts signed by a trusted publisher to be
run on Windows server..

Install the digital certificate:
1.

Open Windows Explorer and navigate to the DR2000v.dll file found in the bin directory of downloaded
Hyper-V package.

2.

Right-click the DR2000v.dll file and click Properties.

3.

On the Properties windows go to Digital Signatures > Details > View Certificate.

4.

On certificate windows, click Install Certificate > select On local Machine > Next and place it under
Trusted Publishers certificate store.

5.

Click OK > Next > Finish.

After the pre-requisites are complete, you can deploy the DR2000v on the local Hyper-v host. For more
information, see the topic “Deploying DR2000v on a Local Hyper-V Host”.

Deploying DR2000v on a local Microsoft
Hyper-V host
NOTE: Ensure all the pre-requisites are complete before deploying the DR2000v on a local Hyper-V
host. For more information, see the topic, “Prerequisites for deploying the DR2000v in Microsoft Hyper-V
environments.”
NOTE: These deployment steps are applicable to Windows 2008 R2, 2012, and 2012 R2 Hyper-V hosts.
To deploy the DR2000v on a local Hyper-V host:
1.

Run the DR2000v command script from the install package.
A command line deployment wizard is displayed with the following options:

2.

a.

LOCAL

b.

REMOTE

c.

CONTROL PANEL
Type option ‘a’ for local deployment and press <Enter>.
The following ACTIONS are displayed:
◦

Deploy

◦

Start

◦

Stop

◦

Delete

◦

Repair

3.

Type action ‘1’ to deploy and press <Enter>.

4.

Type the appropriate DR2000v Hyper-V name and press <Enter>.
DR2000v Deployment Guide
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The following options to select storage size are displayed:
a.

1TB Data Storage Size

b.

2TB Data Storage Size

c.

4TB Data Storage Size

d.

12TB Data Storage Size
NOTE: Windows 2008 R2 version of the DR2000v does not offer 4TB or 12TB data storage option.

5.

Type option ‘a’, ‘b’, or ‘c’ as appropriate and press <Enter>.
The DR2000v Hyper virtual machine code is now deployed and this process will take approximately 2–
3 minutes. A message is displayed showing the deployment progress, that is creating of new DR2000v
template, processing the DR2000v image, and populating the virtual machine with DR2000v configurations.
A message appears when the deployment has completed successfully

6.

When prompted to deploy another DR2000v, type ‘y’ for yes or type ‘n’ for no as appropriate and press
<Enter>.

7.

Type option ‘2’ and press <Enter> to start the DR2000v virtual machine to self extract the installation
packages and install all the DR2000v components.

8.

Enter the name of the DR2000v virtual appliance to start.

9.

When prompted to start another DR2000v, type ‘y’ for yes or type ‘n’ for no as appropriate and press
<Enter>.

The Local Deployment menu is displayed again.

The Local Deployment menu is displayed again.
10. Next launch Hyper-V Manager. Navigate to Start Menu > Administrative Tools > Hyper-V Manager.
The Hyper-V Manager window is displayed.
11. Select the host where DR2000v VM resides.
12. Right-click the DR2000v VM and select Connect to view the installation process
Depending on your system resources, it may take 10 - 20 minutes to self extract installation packages and
components.
Once the DR2000v VM has been created, you will be prompted to convert the disk from dynamic (sparse)
to fixed disk. A warning and prompt appears stating:
WARNING: If the DR VM underlying storage runs out of space it will bypass some
of the built-in data integrity features. Hence, it is recommended to convert
the Dynamic VHD to Fixed VHD for this DR VM. Please refer to the relevent
Microsoft Hyper-V documentation or call Quest support. Do you want to convert
the dynamic expanding VHD to Fixed VHD? (y/n)?
At the prompt, enter y or n as appropriate.
13. After installation, proceed with the initial setup and configuration of the DR2000v as described in the topic,
“Configuring the DR2000v.”

Prerequisites for deploying the DR2000v
on a remote Hyper-V host
For any DR2000v deployment, the first step is to install the DR2000v license on an associated DR Series system
hardware appliance. For more information, see the topic “Setting Up the License for the DR2000v.”
Ensure that the following prerequisites are met before deploying the DR2000v on a remote Hyper-V host:

DR2000v Deployment Guide
Prerequisites for deploying the DR2000v on a remote Hyper-V host

14

1.

Both local and remote hosts/servers must have similar operating systems. For example, you cannot deploy
a DR2000v with a Windows 2008 R2 host to a Windows 2012 R2 server.

2.

Ensure that enough space is available on the remote machine before you start to deploy the DR2000v.

3.

Ensure that the following software requirements are included in both local and remote server/hosts:
◦

.NET Framework 4.5

◦

Windows PowerShell 4.0

◦

Windows Remote Management (WinRM) v2.0

4.

Ensure you have administrator privileges or you must be a member of the administrator’s group.

5.

Extract the downloaded DR2000v installation package on the Hyper-V host to access its files. It may take
a couple of seconds for the files to be extracted. Before executing the Hyper-V installation process, the
software pre-requisites are to be met.
NOTE: This software is easily accessible from the Pre-Requisites folder. The prerequisite file names
may change due to different DR2000v OS versions and also other updates may be required.
NOTE: For your convenience, both online and offline versions of .NET 4.5 are available with the .NET
security update files and Microsoft Management Framework 4.0 package.

6.

Ensure that the following Windows commands are run on both local and remote hosts:

7.

◦

Install-WindowsFeature Hyper-V-Tools – This command enables Windows to administer
Hyper-V.

◦

Install-WindowsFeature Hyper-V-PowerShell – This command installs additional
PowerShell commands specialized for Hyper-V.

◦

Set-ExecutionPolicy AllSigned – This command allows scripts signed by a trusted publisher
to be run on a Windows server.

You can run commands on one or hundreds of computers with the following single PowerShell command
syntax: Invoke-command —computername server01, server02, —scriptblock {commandto-run}. For more information on the Invoke command, go to technet.microsoft.com/en-us/library/
dd347578.aspx.
Use PowerShell to issue the three commands prerequisites to both local and remote systems, for example:

8.

◦

Invoke-command —computername localserver01, server02, server03 –scriptblock
{install-WindowsFeature Hyper-V-Tools}

◦

Invoke-command —computername localserver01, server02, server03 –scriptblock
{install-WindowsFeature Hyper-V-PowerShell}

◦

Invoke-command —computername localserver01, server02, server03 –scriptblock
{Set-ExecutionPolicy Allsigned -Force}

Install the digital certificate using the Certificate Import Wizard:
a.

Open Windows Explorer and navigate to the DR2000v.dll file in the bin directory of the downloaded
DR2000v package.

b.

Right-click the DR2000v.dll file and click Properties.

c.

On the Properties windows, go to Digital Signatures > Details > View Certificate.

d.

On certificate windows, click Install Certificate > select On local Machine > Next and place it under
Trust Root Certification Authorities and Enterprise Trust certificate stores.

e.

Click OK > Next > Finish.

After the prerequisites have been met and drive capacity requirements are changed, you are ready to deploy the
DR2000v on a remote Hyper-v host. For more information, see the topic “Deploying the DR2000v on a Remote
Hyper-V Host”.
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Changing the storage paths for Hyper-V
deployment
If an alternate storage location is required for the DR2000v virtual appliance due to capacity limitations or for other
reasons, the remote Hyper-V host Virtual hard disks and Virtual machine paths must be changed before the
DR2000v is deployed.
NOTE: The capacity requirements of the DR2000v are beyond 200GB. For example, if a 2TB DR2000v is
to be deployed a 2.2TB storage capacity will be required.
To change the storage paths follow these steps:
1.

Log on and connect to the remote machine using Remote Desktop Protocol (RDP) using the following
command: mstsc /v:<remote server IP address>

For example: mstsc /v:127.0.0.1
2.

Open the file manager and identify the volume that has free capacity for DR2000v deployment.

3.

Create a folder in this location.

4.

With the storage needs identified, change the Hyper-V virtual machine storage locations. From the local
machine, navigate to Start Menu > Administrative Tools > Hyper-V Manager.
The Hyper-V Manager window is displayed.

5.

Connect to the host where the DR2000v will be deployed.

6.

Right-click the host, and select Hyper-V settings.
The Hyper-V settings window is displayed.

7.

Change both the Virtual hard disks and Virtual machine path settings to the same new path, and click
OK.
The DR2000v machine is ready to be deployed.

Deploying the DR2000v on a Remote
Hyper-V Host
NOTE: Ensure all the pre-requisites are complete before deploying the DR2000v on a remote Hyper-V
host. For more information, see topic “Prerequisites for deploying DR2000v on a remote Hyper-V host.”
NOTE: For remote deployments you must access the DR2000v deployment files using Universal Naming
Convention (UNC) path names and not mapped drive shares. The C: drive is the default share, so you
should place the DR2000v deployment files on the local machine.
1.

From the local machine, access the DR2000v deployment package using a UNC path name.

2.

Run the DR2000v command script from the install package using the UNC path name.
A command line deployment wizard is displayed with the following options:

3.

a.

LOCAL

b.

REMOTE

c.

CONTROL PANEL
Type option ‘b’ for remote deployment and press <Enter>.
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You will be prompted to enter the remote hostname and user credentials for accessing it.
4.

Type the remote hostname or fully qualified domain name (FQDN) of the remote host and press <Enter>.

5.

Type the domain\user name for an authorized user of the remote host and press <Enter>.

6.

Type the password for this user and press <Enter>.
The following Remote Deployment menu of actions is displayed:
◦

Deploy

◦

Start

◦

Stop

◦

Delete

◦

Repair

7.

Type action ‘1’ to deploy and press <Enter>.

8.

Type the appropriate DR2000v Hyper-V name and press <Enter>.
The following options to select storage size are displayed:

9.

a.

1TB Data Storage Size

b.

2TB Data Storage Size

c.

4TB Data Storage Size

d.

12TB Data Storage Size

Type option ‘a’, ‘b’, or ‘c’ as appropriate and press <Enter>.
The DR2000v Hyper virtual machine code is now deployed and this process will take approximately 2–
3 minutes. A message is displayed showing the deployment progress, that is creating of new DR2000v
template, processing the DR2000v image, and populating the virtual machine with DR2000v configurations.
A message is displayed when the deployment has completed successfully

10. When prompted to deploy another DR2000v, type ‘y’ for yes or type ‘n’ for no as appropriate and press
<Enter>.
The Deployment menu is displayed again.
NOTE: Before any remotely deployed DR2000v virtual appliance can be started, its virtual network
adapters need to be manually connected to a virtual switch.
11. Open local machine Hyper-V Manager. Navigate to Start Menu > Administrative Tools > Hyper-V
Manager.
The Hyper-V Manager window is displayed.
12. Right-click Hyper-V Manager and select Connect to Server.
13. In Select Computer window, enter the name of the remote Hyper-V host that the DR2000v was remotely
deployed to.
14. Right-click the DR2000v virtual appliance and click Settings.
15. On the Settings window, click the NIC0 hardware object and choose the Virtual Switch to connect, repeat
this step for NIC1 and click OK to apply these settings.
16. Right-click the DR2000v virtual appliance and click Start to self extract the installation packages and install
other components.
17. Right-click the DR2000v virtual appliance again and select Connect to view the installation process
Depending on your system resources, it may take 10 - 20 minutes to self extract installation packages and
components.
Once the DR2000v VM has been created, you will be prompted to convert the disk from dynamic (sparse)
to fixed disk. A warning and prompt appears stating:
WARNING: If the DR VM underlying storage runs out of space it will bypass some
of the built-in data integrity features. Hence, it is recommended to convert
the Dynamic VHD to Fixed VHD for this DR VM. Please refer to the relevent
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Microsoft Hyper-V documentation or call Quest support. Do you want to convert
the dynamic expanding VHD to Fixed VHD? (y/n)?
At the prompt, enter y or n as appropriate.
18. After installation, proceed with the initial setup and configuration of the DR2000v as described in the topic,
“Configuring the DR2000v.”

Converting from dynamic (sparse) to fixed
disk
For DR Series software version 4.0.0.1 or later: Once you have created a new DR2000v VM, you will be
prompted to convert the disk from dynamic (sparse) to fixed disk automatically. At the prompt, enter y for yes or n
for no as appropriate.
For DR Series software versions earlier than 4.0.0.1: Once the DR2000v has been deployed on Hyper-V, you
will need to manually convert the disk from dynamic (sparse) to fixed disk. This process involves the following:
•

Deploying a VM with default options (dynamically expanding)

•

Converting the data disk to Fixed Disk.

•

After successful conversion, editing the data disk option to select the new fixed disk.

•

Rebooting the VM.
NOTE: The total storage space needs to be equal or higher to the size of the existing disk, plus the size of
the new disk. For example, for a 12TB VM, if the existing data disk has grown to 10 TB, the total available
space needs to be a minimum of 10TB (existing) + 12TB (new).
NOTE: The conversion process can take up to several hours, depending on the storage throughput.
NOTE: After the new disk is created, the old disk can be deleted to free up the space

Follow these steps to convert from dynamic to fixed disk manually (for DR Series software versions earlier than
version 4.0.0.1):
1.

After the VM is deployed, open Hyper-V Manager, right-click the VM, and click Settings to edit the VM
settings.

2.

In the Settings window, under Hardware, select the Hard Drive, and then, in the Media pane, select Virtual
data disk and click Edit.

3.

In the Edit Virtual Hard Disk Wizard dialog box, select Convert and click Next.

4.

Select Fixed size as the disk type you want to use for the converted virtual hard disk, and then click Next.

5.

Enter a path/location and name for the new disk, and click Next. (You should save it in the same location
as the existing disk. )

6.

Review your changes, and then click Finish to complete the wizard.
NOTE: This process can take up to several hours, depending on the storage throughput.

7.

Once the disk has been created, in Hyper-V Manager, select the newly created Virtual hard disk and boot
the VM.
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Using the supported cmdlets for the
DR2000v for Hyper-V
The supported cmdlets for the DR2000v for Hyper-V include capabilities for creating a new DR2000v as well as
shutting down, restoring, and removing a DR2000v.
The supported cmdlets are included in binary modules such as DR2000v.dll and DR2000v. psd1. The .dll
and .psd1 files are included in the uncompressed installation package under the “bin” folder.
To use these cmdlets, you must ensure the prerequisites have been met for Hyper-V as described in the topic,
“Prerequisites for deploying the DR2000v on Microsoft Hyper-V.”

New-DR2000v
Purpose
To create a new DR2000v virtual machine.
Syntax
New-DR2000v -Name <DR2000v name> -Image <absolute path to DR2000v Image zip> -Size
<size of the image> [-ComputerName <VMHost Name>] [-UserName] <username> -Password
<password>]
Parameters
•

Name: Specify the DR2000v name.

•

Image: Specify the UNC path location of the DR2000v base image file. In PowerShell, this will provide the
UNC path $env:DR_ImagePath. For example:
New-DR2000v -Name DR2000v-New -Image $env:DR_ImagePath

•

Size: Specify the size of the image with one of the following values: 1TB, 2TB, or 4TB. (Note that 4TB is
only available for Microsoft Hyper—V 2012 and Microsoft Hyper–V 2012 R2.)

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
◦

•

UserName: Specify user name.
◦

•

Optional parameter. If not specified, the local host name will be used.
Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
◦

Optional parameter. If not specified, cmdlet runs in current user context.

Remove-DR2000v
Purpose
To delete the DR2000v virtual machine.
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Syntax
Remove-DR2000v –Name <DR2000v Name> -ComputerName <VMHost Name>] [-UserName
<username> -Password <password>
Parameters
•

Name: Specify the DR2000v name.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
◦

•

UserName: Specify user name.
◦

•

Optional parameter. If not specified, the local host name will be used.
Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
◦

Optional parameter. If not specified, cmdlet runs in current user context.

Repair-DR2000v
Purpose
To restore the DR2000v operating system (OS) to the original firmware level, without impacting stored deduped
data. (This operation is equivalent to using the Restore Manager on a physical DR Series system.)
Syntax
Repair-DR2000v –Name <DR2000v Name> -Image <absolute path to DR2000v Image zip> [ComputerName <VMHost Name>] [-UserName <username> -Password <password>]
Parameters
•

Name: Specify the DR2000v name.

•

Image: Specify the UNC path location of the DR2000v base image file.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
◦

•

UserName: Specify user name.
◦

•

Optional parameter. If not specified, the local host name will be used.
Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
◦

Optional parameter. If not specified, cmdlet runs in current user context.

Start-DR2000v
Purpose
To start a DR2000v virtual machine.
Syntax
Start-DR2000v —Name <DR2000v Name> —SwitchName_NIC0 <switch name> _SwitchName_NIC1
<switch name> [—ComputerName <VM Host Name>] [—UserName <username> —Password
<password>]
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Parameters
•

Name: Specify the DR2000v name.

•

SwitchName_NICx: Specify the virtual switch for the virtual NICs.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
◦

•

UserName: Specify user name.
◦

•

Optional parameter. If not specified, the local host name will be used.
Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
◦

Optional parameter. If not specified, cmdlet runs in current user context.

Stop-DR2000v
Purpose
To shut down the virtual machine gracefully.
Syntax
Stop-DR2000v –Name <DR2000v Name> [-ComputerName <VMHost Name>] [-UserName
<username> -Password <password>]
Parameters
•

Name: Specify the DR2000v name.

•

ComputerName: Specify the Hyper-V server name, hostname, or fully qualified domain name.
◦

•

UserName: Specify user name.
◦

•

Optional parameter. If not specified, the local host name will be used.
Optional parameter. If not specified, cmdlet runs in current user context.

Password: Specify password.
◦

Optional parameter. If not specified, cmdlet runs in current user context.

NOTE: The Start-DR2000v and Stop-DR2000v are Power Shell Cmdlets that must be added into your
scripting infrastructure for management.
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Configuring the DR2000v
The following steps describe how to set up and configure the DR2000v for the first time.
1.

After deploying the DR2000v, wait for the virtual appliance to boot completely. It takes approximately 10-20
minutes to self-extract the installation package and all of the components.

2.

Log on to the DR2000v virtual machine (VM) console using the default Username: administrator and
Password: St0r@ge! The Initial System Configuration Wizard is displayed.

3.

On Initial System Configuration Wizard screen, type yes and press <Enter> to finish the Initial System
Configuration on network settings.

4.

Follow through the wizard to configure the required network entries and confirm the configuration settings.
•

If DHCP configuration is used all of the entries are done automatically.

•

If Static IP configuration is used all of the entries must be entered manually.

After the required network settings are configured, the VM will run the initial configuration, which may take up to
3-4 minutes to complete.
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Deploying and configuring the
DR2000v trial version
This chapter describes the steps for deploying and configuring the DR2000v 30–day trial.
NOTE: The DR2000V trial version does not require a license to be installed for use. If a registration
request message occurs during your 30-day trial, you can safely ignore the message.
NOTE: Converting from trial to production: A DR2000v trial version can be converted to a production
system when:
•

A DR2000v license is purchased and installed.

•

The evaluation time has not expired. The registration of a DR2000v during a 30–day evaluation is
possible if the evaluation time has not expired.

Deploying a DR2000v trial version in
VMware environments
The following instructions describe the steps for deploying the DR2000v trial in a VMware environment by using
the vSphere or Web client.
1.

Acquire the DR2000v trial installation package and store it on your system or a network location. This
package is in VMware ESXi ova format.
To download the trial version, visit the following link: https://www.quest.com/products/dr2000v-virtual-backupappliance/software-downloads.aspx

2.

Using vSphere Client or Web Client, deploy the downloaded OVF template as described earlier in this
document.

Deploying a DR2000v trial version in
Microsoft Hyper-V environments
To deploy the trial DR2000v in a Microsoft Hyper-V environment, follow these steps:
1.

Download the DR2000v trial version and store it on your system or network location. To download the trial
version, visit the following link: https://www.quest.com/products/dr2000v-virtual-backup-appliance/softwaredownloads.aspx

2.

When you have obtained the DR2000v trial installation package, extract the downloaded DR2000v trial
installation package to the Hyper-V host.

3.

Implement the prerequisite software, commands, and digital certificates that are outlined in the topic,
“Prerequisites for deploying the DR2000v in Microsoft Hyper-V environments,” previously in this guide.
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NOTE: Some of the prerequisite files are conveniently located in the extracted DR2000v installation
package within the prerequisites folder. Additionally, Windows 2008R2 Hyper-V has a specific set
of requirements you should ensure are met as described in the earlier topic in this guide, “Additional
prerequisites for deploying the DR2000v in Microsoft Windows 2008 R2 Hyper-V environment.”
Windows 2012 and 2012R2 has a specific set of requirements as described in the topic in this guide,
“Additional prerequisites for deploying the DR2000v in Microsoft Windows 2012 and 2012R2 Hyper-V
environment.”
4.

Refer to the topic “Deploying a DR2000v on a local Microsoft Hyper-V Host” earlier in this document, and
follow the instructions for deployment. When prompted to select a storage size, select 2TB Data storage
size, which is supported for the trial version.

Configuring a DR2000v trial version
The following instructions describe the steps for configuring the DR2000v trial for use.
1.

2.

Launch and follow the steps of the DR2000v Initial System Configuration Wizard:
a.

Power up the DR2000v and open the virtual machine console. It may take 5-10 minutes to selfextract the installation packages and install the components.

b.

Log on to the DR2000v with the default credentials. (username: administrator and
password:St0r@ge!)

c.

Proceed through the first-time Initial System Configuration Wizard, providing the proper network
settings for use within your environment.

d.

When prompted to register, enter eval (No licensing or registration is necessary).

In a Web browser, launch the DR2000v trial version GUI using the IP address, logging on with the default
credentials (username: administrator and password:St0r@ge!).
NOTE: If you are accessing the UI for the first time, the Configuration Wizard will walk you
through the process of configuring the system for the first time. To access the Configuration
Wizard (if it is not open in the GUI when you log on), in the Action menu in the upper right corner
of the System Configuration page, click Configuration Wizard.)
a.

If the Virtual machine Update Manager is more recent than what the DR2000v is running,
download it at: Virtual Machine Update Manager.

The deployment of the DR2000v Trial version is complete.
b.

If you want to update the DR2000v to the latest version, in the left navigation menu of the
GUI, click Support > Software Upgrade. Then, click Select DR binary package, select the
downloaded Virtual Machine Update Manager file downloaded earlier, and click Start Upgrade.
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About us
We are more than just a name.
We are on a quest to make your information technology work harder for you. That is why we build communitydriven software solutions that help you spend less time on IT administration and more time on business
innovation. We help you modernize your data center, get you to the cloud quicker and provide the expertise,
security and accessibility you need to grow your data-driven business. Combined with Quest’s invitation to the
global community to be a part of its innovation, and our firm commitment to ensuring customer satisfaction, we
continue to deliver solutions that have a real impact on our customers today and leave a legacy we are proud of.
We are challenging the status quo by transforming into a new software company. And as your partner, we work
tirelessly to make sure your information technology is designed for you and by you. This is our mission, and we
are in this together. Welcome to a new Quest. You are invited to Join the Innovation™.
Our brand, our vision. Together.
Our logo reflects our story: innovation, community and support. An important part of this story begins with the
letter Q. It is a perfect circle, representing our commitment to technological precision and strength. The space in
the Q itself symbolizes our need to add the missing piece — you — to the community, to the new Quest.
Contacting Quest
For sales or other inquiries, visit https://www.quest.com/contact.
Technical support resources
Technical support is available to Quest customers with a valid maintenance contract and customers who have trial
versions. You can access the Quest Support Portal at https://support.quest.com.
The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. The Support Portal enables you to:
•

Submit and manage a Service Request.

•

View Knowledge Base articles.

•

Sign up for product notifications.

•

Download software and technical documentation.

•

View how-to videos.

•

Engage in community discussions.

•

Chat with support engineers online.

•

View services to assist you with our product
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